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MINI MITTER, a Respironics Company  

WARRANTY POLICY  

1. WARRANTY: Mini Mitter, a Respironics Company, warrants that upon delivery the goods sold hereunder will be free of 
defects in materials and workmanship, and such goods will substantially conform to the specifications furnished by the Seller, 
and to any drawings or specifications furnished to the Buyer by the Manufacturer (Mini Mitter, a Respironics Company) if 
approved by the Manufacturer.  

a) Commencement of Warranty – The warranty period begins on the date of delivery.  

b) Duration of Warranty – The goods sold hereunder are warranted for a period of twelve months, except PDT-4000 and PDT-
4000HR, which are warranted for two years.  

c) Third Party Product Warranty – Third party products purchased by Buyer through the Manufacturer are covered by the 
third party’s warranty and ARE NOT COVERED BY THE MANUFACTURER WARRANTY.  

d) Place of Repair or Replacement. Buyer must return the defective or nonconforming goods upon request to Mini Mitter, a 
Respironics Company, at 20300 Empire Avenue, Building B-3; Bend, OR 97701, not later than 15 days after the 
Manufacturer’s receipt of notice of the alleged defect or nonconformance. Buyer shall prepay transportation charges. The 
Manufacturer shall pay for the return of the goods to Buyer. No goods are to be returned to the Manufacturer without prior 
authorization and a valid Return Authorization (RA) number.  

e) Limitation of Warranty The foregoing warranty shall not apply to defects resulting from (a) improper or inadequate 
maintenance by Buyer; (b) unauthorized modification of the goods; (c) operation of the goods outside of the environmental 
specifications for the goods; (d) neglect, misuse or abuse of the goods or (e) modification or integration with other goods not 
covered by a Mini Mitter, a Respironics Company, warranty when such modification or integration increases the likelihood of 
damage to the goods.  

f) Technical assistance – The warranty set forth above shall not be enlarged, diminished or affected by and no obligation or 
liability shall arise from the Manufacturer’s rendering of technical advice, assistance or services in connection with Buyer’s 
order of the goods furnished hereunder. The Buyer is not relying on the Manufacturer’s skill or judgment to select or furnish 
suitable goods.  

THE WARRANTY SET FORTH ABOVE IS EXCLUSIVE AND THE MANUFACTURER GIVES NO OTHER 
WARRANTY WRITTEN OR VERBAL, EXPRESS OR IMPLIED. MINI MITTER, A RESPIRONICS COMPANY, 
SPECIFICALLY DISCLAIMS THE IMPLIED WARRANTIES OF MERCHANT-ABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE. THE MANUFACTURER’S STANDARD WARRANTY POLICY COVERING ANY OF THE 
MANUFACTURER’S PRODUCTS SHALL BE NULL, VOID, AND OF NO EFFECT IF THE BUYER OR ANY THIRD 
PARTY USES THAT PRODUCT FOR ANY USE OTHER THAN THE INTENDED USE OF THAT PRODUCT.  

2. LIMITATION OF REMEDIES AND LIABILITY. The remedies provided herein are Buyer’s sole and exclusive remedies. 
The Manufacturer shall have no responsibility other than, at the Manufacturer’s option, to repair or replace defective or 
nonconforming goods or to refund the purchase price of defective or nonconforming goods in the event of breach of any 
warranty. IN NO EVENT SHALL THE MANUFACTURER BE LIABLE FOR ANY DIRECT, INDIRECT SPECIAL, 
INCIDENTAL OR CONSEQUENTIAL DAMAGES (INCLUDING LOSS OF PROFITS) WHETHER BASED ON 
CONTRACT, TORT OR ANY OTHER LEGAL THEORY. In the event that any limitation of warranty or disclaimer of liability 
is found to be unlawful or inapplicable, or to have failed of its essential purpose, the Manufacturer’s liability shall be limited to 
the amount paid by the Buyer for the specific goods that caused such liability.  
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Thank You! .....for purchasing products from Mini Mitter, a 
Respironics Company. If you need assistance with 
your Actical products, remember our support 
continues after the purchase. If you have any 
problems or questions, please call our Technical 
Support staff of technicians, engineers and 
scientists. We are available by telephone,  
e-mail or website.  

 

Contacting Technical Support  

Mailing and 
Shipping 
Address 

Mini Mitter Company, Inc.  
A Respironics, Inc. Company 
20300 Empire Avenue, Building B-3  
Bend, Oregon  97701 USA  

Telephone (800) 685-2999  
(541) 598-3800 

E-Mail mm@respironics.com  

Website www.minimitter.com  
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SECTION 

INTRODUCTION  
This is an instruction manual for the operation and care of the Actical 
physical activity monitoring system. Hardware includes the device which 
records motion data, the Actical activity monitor, and the ActiReader, the 
means by which data are sent and received from the Actical monitoring 
device. Actical has been designed for recording physical activity. The 
Actical activity monitor is lightweight, and can be worn on the hip 
(waist), wrist or ankle. 

Actical Description  

Components  

• Actical® Activity Monitoring Device  

• Hip belt and wrist/ankle band for mounting Actical 

• Actical Software Application CD 

• ActiReader, RS-232 Cable, and Power Cable 

• This Manual  
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Symbols 

The symbols shown below are used on Actical or ActiReader and 
throughout this manual. 

 
Attention, consult accompanying documents 

 
Type BF Applied Part 

 
Canadian/US Certification 

IPX7 Protected against the effects of temporary 
immersion in water (Actical device) 

 

European Declaration of Conformity (conformance 
to Radio and Telecommunications Terminal 
Equipment (RTTE) Directive) 

 
European Declaration of Conformity (conformance 
to Medical Device Directive (MDD)) 

 

Alignment indicator (ActiReader) 

 Power On indicator (ActiReader) 

 DC Power (ActiReader) 

 

Compliant with the Waste Electrical and Electronic 
Equipment/Restriction of the Use of Certain 
Hazardous Substances in Electrical and Electronic 
Equipment (WEEE/RoHS) recycling directives 
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Abbreviations 

The following abbreviations are used in this manual. 

1R Single Regression Line 
2R Double Regression Line 
AC Activity Counts 
ADV Advanced Display 
AEE Active Energy Expenditure – the number of kilocalories 

expended per minute per kilogram of subject weight 
AvgAC Average Activity Counts 
AvgEE Average Energy Expenditure 
EE Energy Expenditure 
Light Light Physical Activity Level 
Met Metabolic Equivalent – the total amount of energy the body 

uses to sustain itself including the basal metabolic rate. 
Mod Moderate Physical Activity Level 
NaN Not a Number 
Sed Sedentary Physical Activity Level 
Time Time Accumulated 
TotAC Total Activity Counts 
TotEE Total Energy Expenditure 
Vig Vigorous Physical Activity Level 
 

WEEE/RoHS Recycling Directives 

If subject to the WEEE/RoHS directives, refer to www.respironics.com 
for the passport for recycling this product.  
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Warnings and Cautions 

Warnings  

A warning indicates a condition that may endanger the user.  

• Do not dispose of lithium batteries in fire or flame. An explosion 
may result. Only dispose in accordance with manufacturer's 
recommendation or local codes. 

Cautions  

The following conditions indicate possible damage to the equipment, 
or erroneous or incomplete data.  

• To retain the integrity of the waterproof seal, you should change the 
O-ring in the battery compartment at the same time you change the 
battery  

• When changing the battery, use extreme care to avoid scratching the 
metal surface of the device or battery cover. Scratches can cause the 
Actical device to leak. 

• Prolonged submersion may cause damage to the device.  

• When replacing the battery, it is very important that the rubber O-
ring in the battery compartment also be changed. The back mounting 
panel should be firmly screwed in place to achieve a waterproof seal. 
The waterproof seals of all devices are checked before leaving the 
factory. To preserve this integrity, it is imperative you follow the 
procedures in Appendix A. 

• Alcohol may interfere with the integrity of the seals. When cleaning 
the device, non-alcohol-based disinfectants should be used. When 
cleaning the battery compartment cover or the metal frame, follow 
the battery change procedures in Appendix A. 
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Intended Use 
The Actical is a compact, lightweight, waist-, wrist-, or ankle-worn 
activity monitor that may be used to assess human gross motor activity, 
caloric expenditure, and estimates of energy expenditure based on motor 
activity in any instance where quantifiable analysis of physical motion is 
desirable. 

Contraindications  

None. 
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Sensor Orientation 
The Actical activity monitoring device uses an accelerometer to monitor 
the occurrence and intensity of motion. This type of sensor integrates the 
amplitude and frequency of motion and produces an electrical current 
that varies in magnitude. Therefore, an increased intensity of motion 
produces an increase in voltage. Actical stores this information in the 
form of activity counts.  
 
Orientation of accelerometer 

Marker button

Accelerometer

 
 

The shape of the sensor makes it most sensitive to motion in specific 
directions. NOTE: To obtain the most repeatable results, it is important 
to mount Actical in the prescribed manner for your physical activity 
study. A detailed description of the method is covered in Positioning 
Actical on page 3-1. 

Marker Button 
Actical is equipped with a marker button  (shown above) on the device’s 
front panel. When pressed, tactile feedback signals the subject that the 
date and time have been successfully marked, and they are recorded in 
memory. 
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Actical Features 
The coin cell battery will typically last 180 days. To replace the battery, 
see Appendix A. 

Calibration  
Actical activity monitoring devices are calibrated at the factory, and the 
calibration offset factors are entered into the memory at that time. It is 
recommended that you return Actical to the factory periodically for 
operational evaluation and re-calibration. 

NOTE: Additional information is available in Specifications in  
Appendix B.  

Time Keeping  
The computer clock sets the Actical start time. Inside the device, a 
crystal oscillator keeps elapsed time. When a sampling epoch is chosen, 
the device waits a specific number of oscillations before storing the 
number of activity counts. This also applies to delayed starting times. 
The time-keeping circuitry does not initiate until the device has been 
removed from the ActiReader. 

NOTE: Actical cannot collect data or keep time while on the ActiReader. 
Do not put Actical on the ActiReader until you are ready to either 
download or setup the device for another data collection session. 

Telemetric Communications Link 
Actical requires no external communications port for uploading setups or 
downloading data. Communication between Actical and the reader is 
established via a wireless link. 

Waterproof 
Actical devices are waterproof to IEC Standard 60529 IPX7. They are 
resistant to water. These devices will tolerate normal daily experiences 
such as shower, spa (hot tub), swimming, skiing, rain, household chores, 
etc. 

CAUTION: Prolonged submersion or exposure exceeding the above 
limits may cause damage to the device. 

 
CAUTION! When replacing the battery, it is very important that the 
rubber O-ring in the battery compartment also be changed. The back 
compartment cover should be firmly attached with four screws to achieve 
a waterproof seal. The waterproof seals of all devices are checked before 
leaving the factory. To preserve this integrity, it is imperative you follow 
the procedures in Appendix A. 
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Maintenance  
Actical has no user-serviceable parts. Return the device to the 
Manufacturer (Mini Mitter, a Respironics Company) for service. 

Cleaning  
Actical may be cleaned by using a cloth moistened with a mild detergent 
and warm water. Cleaning with alcohol-based solvents should be avoided 
to prevent deterioration of the seal. 

CAUTION! Do not autoclave Actical.  

Cleaning Actical Bands 
Actical bands can be washed and reused. However, it should be noted 
that Actical studies involve mounting Actical on the body. With some 
subjects, this may raise particular sensitivities with respect to reusing the 
bands, and that should be taken into consideration. Additional bands are 
inexpensive and are available from the manufacturer. Clean the band as 
follows. 

1 Remove the band from the device. 
2 The band may be laundered as any other article of clothing, using 

household or industrial detergent and a regular cycle. 
3 Air dry. It is not recommended that the band be dried in the clothes 

dryer. 

Cleaning Actical Devices 
Only when the battery cover is installed and the fully sealed should 
Actical be disinfected.  

CAUTION! Do not disinfect this device while the battery cover is off. 

Actical may be cleaned with disinfectants such as Cavicide®, 
Envirocide®, Extran®, and other commonly used laboratory and hospital 
products. Disinfecting with alcohols such as isopropanol and ethanol is 
not recommended. Repeated exposure may compromise the sealants used 
in Actical. Clean the Actical device as follows. 

1 Follow the label directions for the disinfectant being used. 
2 Disinfect with the battery cover on. 
3 Spray or wipe down Actical thoroughly with the disinfectant. Do not 

soak. 
4 Gently dry with a paper towel or soft cloth. 
5 Mount Actical back on the laundered band. 
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SECTION 

INSTALLING ACTICAL  
AND ACTIREADER 

System Requirements 
• Windows-compatible computer  
• Use only an IEC/UL/CSA 60950 compliant computer 
• Pentium® II Processor with a clock speed of at least 266 MHz  
• 64 MB or more of internal memory (RAM)  
• Windows® 98, Millennium, Windows NT 4.0, Windows 2000, 

or Windows XP 
• CD-ROM drive  
• 300 MB or more free space on the hard disk  
• 9-pin or 25-pin RS-232 communications serial port 
• Super Video Graphics Array (SVGA - 800 x 600 pixels 

required to view all data displays)  
• Printer (optional)  

 

NOTE: The recommended configuration is a Pentium III (or better), 866 
MHz (or faster) processor, and at least 128MB of RAM.  
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Preferred Settings 
Actical software is best used with the following computer display 
settings. Directions for changing these settings can be found in the 
Online Help feature of your specific operating system. 

 
Monitor area or  
  monitor resolution  
 

Set the resolution for 800 x 600 or higher.  
The recommended resolution is 1024 x 768.  

Appearance scheme  
  (or theme)  
 

Avoid “High Contrast” or “Extra Large” 
schemes. Windows Standard is recommended. 

Font sizes  For display items related to fonts and font 
sizes, select “Normal” or “Small font” (font 
sizes of 12 points or less). Eight point font 
size is recommended because it allows you to 
see more information than with larger font 
sizes.  
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Installation Preparation 

NOTE: Before beginning the installation procedure, make sure that no 
other applications are currently running on the computer. This includes 
MS Office® and any other utilities. These can interfere with proper 
installation, resulting in software conflicts.  

Remove any previously installed versions of Actical software before 
installing a newer version.  

Uninstalling Previous Actical Application Program  
1. To remove the installed version of Actical, click the 

START button and open the Control Panel. 

2. Click the Add/Remove Programs symbol and look 
for an item labeled Actical.  

3. Select Actical and click Add/Remove.  

4. Follow the displayed instructions. Once the uninstall program has 
completed, all program files and shortcuts will have been 
removed. If you find any desktop shortcuts on your desktop that 
you may have created, please delete them.  
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Installation of Actical Software  

CAUTION: If you are upgrading from an earlier version of Actical 
software already installed on your computer, be sure to uninstall the 
previous version using the uninstall procedure described in the previous 
section. If the earlier version is not uninstalled, the program will not 
work correctly. 

Order of Installation  
1 Place the Application Program CD in the CD drive of the computer. 

The CD is set to auto-install. The installation window should appear.  

NOTE: If your CD drive does not accommodate auto installation, click 
the Start button, then Run, and type the drive letter of your CD drive and 
colon (such as D: or E: ), and then type setup.exe in the field, as shown 
below. Then click on OK.  

 

 

2 Follow the installation instructions to install the Actical 
Application Program.  

3 If the installation is successful, you will see a message on the screen 
saying so. Click OK to complete installation.  
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Starting Actical 
1 Click on the Windows Start button, and choose Programs. 

2 Click Start > Programs > Actical > Actical. The Actical Main window 
will open (shown below). 

 
 
Main window 
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Installing ActiReader 
An ActiReader or an Actiwatch® Reader is necessary to communicate 
with the Actical activity device. Connection to a computer or laptop is 
very similar to any other peripheral device. 

 
 

Computer with ActiReader 

 

NOTE: Communication between the ActiReader or Actiwatch Reader 
and the computer is very similar for both Actical and Actiwatch. 

NOTE: Follow the recommendations supplied with your computer when 
connecting peripheral devices. Most manufacturers suggest powering 
down the computer while connecting hardware to a COM Port. 

1 Connect one end of the serial communication cable (supplied) to a 
COM Port on your computer. 

2 Connect the other end of the communication cable to the ActiReader. 
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3 Make sure the COM Port of Actical is set to the same COM Port to 
which you have just connected in the previous step. Open the Actical 
software program and click on Reader > COM Port and then select 
your COM Port from the list as shown below. 

 
Selecting a COM Port 
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Using ActiReader 

NOTE: Remove the Actical device from the patient before placing it on 
the ActiReader. 

 

NOTE: Use only an IEC/UL/CSA 60950 compliant computer with the 
ActiReader. 

ActiReader details 

 
 

1 When the COM Port is set correctly and ActiReader is connected to 
the computer, open Actical (see Starting Actical on page 2-5). 

2 It is possible that the green LED will light when the reader is first 
connected to the computer. This occurs when it is not connected to the 
COM port selected in the software. When the COM ports are properly 
set, the green LED will not light.  
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The following are ActiReader components: 

 
External power 
source 
 

ActiReader can be powered using an external 
power source cable (supplied). When plugged 
in to the side of the device, it will disconnect 
the battery to conserve it. 
 

Power ON/OFF 
switch 
 

This switch will disconnect ActiReader from 
its power source, whether AC or battery. 
 

Power On indicator 
(Red LED)  
 

Whether using external power or the internal 
battery, the red LED will light when the Power 
switch is ON. 
 

Alignment indicator 
(Green LED) 
 

When Actical is aligned properly with 
ActiReader, this green LED will light. 
 

Communication pad 
indicator 
 

This slot ensures Actical is placed properly. On 
the metal back of the Actical device is a green 
dot in one corner. When the dot is aligned with 
the green dot on ActiReader, the green LED on 
the ActiReader will light. This indicates that 
communication between the two devices is 
possible. 
 
NOTE: The back of the Actical device is metal. 
The front or face of the device is gray plastic. 
 

RS-232 serial port 
connection 
 

This is where the serial cable connects to 
ActiReader. The other end connects to the 
COM port on the computer. 

 
However, please keep the following in mind when using the ActiReader 
or Actiwatch Reader: 

• The ActiReader is black. The Actiwatch Reader is white.  
• Researchers with laptop computers may switch the ActiReader to 

Battery Power for proper function.  
• If using battery power, you may need to replace the reader battery 

periodically (see Replacing ActiReader Battery later in this section). 
• The COM port selection in the software must be correct, and the 

communications wizard must be running, for the Ready LED to be lit. 
 
CAUTION! The black ActiReader device uses a 9V Lithium battery. The 
white Actiwatch Reader uses a standard 9V battery. These batteries are 
not interchangeable, and may result in damage to your device. Use of the 
improper battery will void the warranty. 
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ActiReader Battery Installation or Replacement 
 

CAUTION! It is important that you thoroughly read the following 
information prior to changing the battery. Failure to follow procedures 
may result in immediate or subsequent damage to the device. 

1 Disconnect the AC electrical supply and set the power toggle 
switch to OFF. 

2 Turn the ActiReader over so the battery cover is facing up. 

3 Slide the battery cover in the direction of the arrow. 

4 Carefully remove the battery from the housing unit and gently 
disconnect the battery terminals. 

5 Replace the battery. 

6 Slide the battery cover back into place on the ActiReader. 

7 Set the power toggle switch to the ON position.   

8 Verify the red LED power light is blinking.  

WARNING!  Do not dispose of lithium batteries in fire or flame. An 
explosion may result. Only dispose of batteries in accordance with the 
manufacturer’s recommendation or local codes. 
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Testing Actical Hardware 
ActiReader and the Actical device can be tested using the Actical 
software. If you believe that your Actical device or ActiReader are not 
operating properly, you can use the following two operations to test their 
functionality and the communications link. 

CAUTION! Testing an Actical device or ActiReader may result in data 
loss in the Actical device. Only use an Actical device that is not being 
used for data collection. 

Testing the Actical Device 
1 Open Actical software. Select from the drop-down menu, Test Actical 

Device. 
 
Main > Reader > Test Actical device 

 

2 Follow the prompts through the test procedure. 
 
Preparing to communicate 
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3 In the case of a communication error, you will be prompted, and will 
be given important steps to take to correct the problem. 

 
Communication error with device 

 
 
 

Testing the ActiReader 

NOTE: This test may take several minutes. 

1 Open Actical software. From the drop-down menu, select Test Reader. 
 
Main > Reader > Test Reader 
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2 Follow the prompts through the test procedure. 
 
Preparing to communicate 

 
 

3 In the case of a communication error, you will be prompted, and given 
important steps you may take to correct the problem. 

 
 

Failed ActiReader test 
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Recover Data 
Activating Recover Data will strip off potentially corrupted header 
information, and replace it with a “recovery header.” 

 
Reader > Recover data 

 

 

 
The recovery header generates a new header based on input from the 
following prompt. 

 
Recovery header 
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The header is then sent to the Actical device in the same manner as in a 
regular setup. Simply follow the prompts. 

 

 

After the header is replaced, the data in the activity monitor memory may 
be recovered using the standard Read procedure. 

NOTE: Completing Recover Data does not restore the data to the 
computer. It only corrects and repairs corrupted header information. You 
must still use the Read procedure to extract the data. 
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SECTION 

POSITIONING ACTICAL 
The Actical activity monitoring device may be worn on the hip (waist), 
wrist or ankle. The Actical monitoring device must be worn correctly for 
several reasons. 
• A correctly positioned Actical will detect and record physical 

activity. Incorrect positioning may result in skewing the data, 
particularly in multiple subject studies. 

• By mounting Actical in the same location on each subject, data 
consistency will be ensured. 

NOTE: Research has shown that the optimal placement of the Actical 
device is the iliac crest of the hip. 

• Hip (waist) – This is considered to be the most accurate. However, 
on occasion, younger subjects have shown to be intolerant of hip-
mounted devices. 

• Wrist - This is considered the second choice for accurate 
measurement of energy expenditure. 

• Ankle - This is considered the third choice for accuracy, however, in 
many cases it has shown to be the most tolerated. 

IMPORTANT: The Actical monitoring device must be mounted on the 
belt or wristband so the sensor is oriented correctly. 
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Hip/Waist Mounting 
Hip mounting is considered to be the most accurate. When Actical is 
worn on the hip (waist), the device must be placed on the mounting tabs 
of the waist band as pictured below.  

1 Using the hip belt, thread the hook and loop mounting tabs through the 
slots in the battery compartment cover (not the frame).  

 

When placed on the strap correctly, the Respironics logo will be 
parallel to the waist strap. 

 
Tab orientation 

 
 

2 Fold the tabs away from the device and affix to the band (see arrows). 
 

Waist band complete 

 
 

For other types of waist bands (those without mounting tabs) simply 
orientate the logo on the Actical device to be parallel with the waist 
band. 
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The belt should be mounted on the body so that the Actical device rests 
on the iliac crest of the hip. The iliac crest is the uppermost and widest of 
the three bones constituting either of the lateral halves of the pelvis. 

 
 

Proper hip mount 
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Wrist Mounting 
Placing Actical on the wrist is considered the second choice for accurate 
measurement of energy expenditure. Proper placement of the Actical is 
shown below.  

 

Using the wrist/ankle band, mount the Actical device by threading the 
band through the battery compartment cover.  

 
Proper band placement 

 

 

When placed on the band correctly, the Respironics logo will be parallel 
to the band and on the edge of the device nearest the elbow. 
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Ankle Mounting 
Ankle mounting is considered the third choice for accuracy; however, in 
many cases it has shown to be the most tolerated.  

Using the wrist/ankle band, mount the Actical device by threading the 
band through the slots in the battery compartment cover (not the frame). 
When placed on the band correctly, the Respironics logo will be parallel 
to the ankle strap. 

Mount Actical on the ankle as shown below. 
 

Proper ankle mount 
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SECTION 

USING ACTICAL  
Setting up the Actical Device 

The Actical physical activity monitoring device must be uploaded with 
setup information prior to collecting data. This is done with the Actical 
software, and then loaded into the Actical device using ActiReader. 

 

1 First, open the Actical software by clicking on the Actical symbol, or 
clicking on Start > Programs > Actical > Actical. The main window 
will open. 

 
       Main window 

        

2 From the drop-down menu, choose Reader > Write, and follow the 
prompts. The setup procedure is as follows. 
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Main window > Reader 

 

3 A warning will prompt you. Writing a setup to an Actical device 
erases previously stored data. 

 
Main window > Reader > Write 

 
 

4 The prompt will instruct you to place the device on the ActiReader. 
 
Place device on ActiReader 

 

5 The Actical activity monitoring device must be placed on the Reader 
per the instructions on the top panel of the reader. (For details, see 
Using ActiReader on page 2-8). When aligned properly on the 
communication pad, the green LED will light. 
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6 Communication will commence as shown by the red progress bar at 
the bottom of the screen. 

 
Communication in progress 
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7 Click in each window to enter the information. You may also use the 
tab key to navigate from field to field. (You should only change the 
Battery Fitted Date field when you install a new battery.)  

 

NOTE: Do not use the following characters or commands. They are 
delimiters.   RETURN, TAB, COMMA, PERIOD, or the following:  < > 
/ !  £  $  %  ^  *  &  (  )  @  ~ 

 

On the Actical Setup screen shown below, the following setup fields are 
shown blank for clarity. 

 
Actical Setup 
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Start date and Start time 
The available delays for start time will depend on the epoch length. See 
the table below for maximum start times. 

Epoch Length 
Number of Epochs 

per Day 
Maximum Delay in 

Start Time 

15  seconds 5760 5 days 

30 seconds 2880 11 days 

1 minute 1440 22 days 

Epoch length 
This is the period of time Actical will accumulate activity counts before 
saving the sample, recording it to memory, and then resetting the counter 
to zero. Select the epoch length by clicking in this field. The choices will 
appear sequentially. 

When all the information has been entered, click Send. The information 
will be sent to the Actical activity monitor. 

NOTE: If you are using the Energy Expenditure function, the epoch 
length will be calculated based on 1-minute epochs even though 15- or 
30-second epochs were chosen during setup. The activity counts within 
the shorter epochs will be added, resulting in no lost activity counts per 
1-minute period.  

Steps 
Step function can be enabled or disabled. If enabled, Actical will record 
the number of steps taken during the collection period. 

NOTE: If Step function is enabled, only 5.5 days (with 15-second epoch) 
of memory will be available. 

Epoch Length 
Number of 
Epochs per Day 

Days Recording 
Time 

Days Recording 
Time with Steps 

15  seconds 5760 11 days 5.5 days 

30 seconds 2880 22 days 11 days 

1 minute 1440 44 days 22 days 
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Retrieving Data from Actical 
Retrieving data from the Actical activity monitoring device (Read 
function) is very similar to sending information to the device (Write). 

 

1 From the drop-down menu bar (shown below), click on Reader > 
Read, and follow the prompts. 
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2 The data download will be shown by the red progress bar at the 
bottom of the window. 

 
Download in progress 

 

3 A message is displayed to tell you when the download is complete. 
 
 

File Menu 

Load 
1 To load Actical data from a file for analysis, select File > Load. 
 
File loading 

 

2 A file browser will appear and enable you to load .awc and .awcEE 
files. 

NOTE: For details on file types, see File Formats on page 6-26. 
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Browser 

 

3 Select the file and click on Open. 
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Save 
This menu item will save data to an .awc file (see note). 

NOTE: For details on file types, see File Formats on page 6-26. 

Join Files 
This function appends one data file to another to form a single file. There 
are restrictions that apply to joining files: 

• The two files to be joined must have been collected using the same 
epoch length. 

• The two files to be joined may not overlap in time.  

• The program has a load limitation of 365 days of data. 

• The settings in File 1 will be the settings for the joined file. Make sure 
File 1 has the preferred settings for the resulting joined file. 

 
 
 

1 From the main menu, select File > Join Files. 
 
Main window menu 
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2 As shown below, the currently loaded file will appear under File 1. 
Click on File 2. Select the file to join to File 1. The second file has 
now appeared in the File 2 fields as shown below. 

 
Joining files: File 1 goes on the left. File 2 goes on the right. 

 

 

Note: Only those files that do not overlap in time and are collected with 
an identical sampling interval may be joined. If you have files with 
different epoch lengths, you may change the epoch length for one of 
them using the actogram display. (Details can be found under Epoch 
Length on page 4-5.) When the second file has been selected, click on 
OK. 
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3 To complete the process, click on Join Files. Direct where the file is to 
be saved. When finished, click on Save. 

 

 

4 A message will announce completion of the joined file. 

 

NOTE: If one or more days transpired between the stop time of the first 
file and the start time of the second file, you may elect to have zeros 
inserted for all epochs between the two dates. Click on Fill blank days. 
The number of samples is the number of data points that will result from 
joining files. This will include epochs inserted if you have elected to fill 
blank days. 

Memory Limitations 
• The largest file size in a collection period is 365 days. This is only 

possible by using the Join Files function. Because of the enormous 
amount of data in such a file, it is not recommended. 

• The maximum number of event marks that can appear in a joined file 
is 4,000. 

• When Step function is enabled, only 5.5 days (with 15 second epoch) 
of memory is available for data collection. 
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SECTION 

ACTOGRAMS 
 

Actogram Main Display 
Actograms are visual displays of the daily activity-rest patterns. When a 
file is loaded, it may be opened as an actogram.  

1 From the Main Actical window, select File > Load to load the file to 
be analyzed. 

2 From the Main Menu, click on Actogram. 

3 A display similar to the one shown below appears. 
 

Typical Actogram 
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Actogram Sliding Bars and Buttons 

Use the sliding bars described below, or click on the arrows to change 
the values. 

NOTE: It may be necessary to click Redraw after changing settings. 

Actogram Display Settings  

 

Light On/Light Off 
The light and dark bars on the actogram may be used to represent day 
and night, or periods of light and dark. You may use the sliding bar, or 
click on the button. Each click will result in a movement of 15 minutes. 

Scale 
The scale of the activity axis may be changed by adjusting the sliding bar. 
If you have a specific value you want to enter, double-click in the 
window and type in the value. This value is also seen on the zoom 
display. This adjustment is useful when observing detail of low activity 
periods. 

Zero 
This function offsets the activity scale. By adjusting the sliding bar, you 
may change the value assigned to the lowest point on the activity axis. 
This value also changes the scale on the zoom display. This adjustment 
may be useful when observing detail of high activity periods. 
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Actogram Display Settings  

 

Start Day/Start Time 
The time and day at which the actogram begins may be changed with the 
sliding bars. 

Redraw 
This refreshes the display. 

Cursor 
This function places the cursor to the specific time shown in the window. 
To do so, use the slide bar or click on the left or right arrows. 
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Actogram Display 

The detail shown on the Actogram display is illustrated below. 

 
Activity Counts 

Activity Counts 
This is a graphical representation of the activity counts per epoch. 

Cursor 
A click anywhere in the actogram will produce a magenta cursor at that 
point in the activity. A third column of numbers will appear on the right. 
This column is the activity counts within the epoch on which the cursor 
is located. 

Total 
This is the total number of activity counts for the day selected. 

Average 
This is the average activity counts per epoch. 
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Actogram Menu Bar 
Actogram Menu Bar 

 
 

File 

The file functions found in this menu are found in other analysis routines 
as well. 

Load 
This function loads data files into Actical software. Use the same 
procedure as Load in the Main window. Actical loads the following file 
types: 

• .awc – Actical file 
• .awcEE - Actical Energy Expenditure file 
 

For more information on file types, see File Formats on page 6-24. 

Print 
This sends the actogram display to a printer. 

Exit 
This closes the actogram display. 

 
Copy 

With the copy command, you may place the data for one day, all days 
displayed on the actogram, or all days of the data file, on the Windows 
clipboard for exportation to a spreadsheet or other application. 

 
Main window > Actogram > Copy 
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Display 

These options determine what is displayed on the actogram. 

 
Main window > Actogram > Display 

 

Redraw 
This option refreshes the actogram display. When observing other 
windows or changing parameters, it may be necessary to redraw the 
actogram. There is also a redraw button near the bottom of the actogram. 

Length  

Auto 
Using Auto displays all of the data collected, beginning with the start day. 

60 days, 20 days 
This option limits the number of days displayed on the actogram. For 
example, 200 days of data in one actogram would be extremely 
“compressed” to the point of being difficult to see. Limiting the number 
of days displayed to 20 is often more practical. 

 
Options 

 Main window > Actogram > Options 

 

Time bars 
Toggles the time bars at the top of the actogram on or off (see below). 

Graticule 
This option toggles the hourly graticule on or off. (Graticules are 
illustrated on the next page.) 
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Graphs 
 Main window > Actogram > Graphs 

 

Average 
This function results in data reduction by averaging multiple days of data, 
as well as calculating the average activity during light and dark periods. 

 
Actogram > Graphs > Average  

Time bars 
 
 

Graticule 
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File 

File has two functions: Print and Exit. 
Copy 

The results from the actogram average process may be copied to the 
Windows clipboard for use in other applications. 

Average Actogram Screen 
This function places the averaged activity and light values for each 
sampling epoch onto the Windows clipboard. The average is calculated 
over the days selected in the Select Days menu. 

Statistics 
This function places the calculations displayed in the lower portion of the 
display onto the Windows clipboard. 

 

1 After you have selected the data you want to move, return to the 
application in which you want to paste the data. 

2 Select the Paste command. (Ctrl-V is a typical keyboard shortcut for 
Paste.) 

 
Data columns will appear in the destination application. A single record 
containing the ID string for the data file will be added to the beginning of 
the file. The first data column will contain time stamps. The second will 
contain activity data. Shown below is a two column copy-and-pasted 
data file.  

 
Lamplighter Study 

Sat 07-Nov-05 

7:30:00 76 

7:31:00 452 

7:32:00 801 

7:33:00 467 

7:34:00 937 

7:35:00 452 

7:36:00 288 

7:37:00 328 

7:38:00 182 

7:39:00 64 

7:40:00 79 
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Selecting Days to Average 
Data from one or multiple days may be used to create an averaging 
display. By default, all days are included when the Average command is 
selected. 

 

1 Activate the Select Days menu. Click to highlight the first day you 
wish to include in your average. 

2 Drag the cursor down the list until you reach the final day to be 
included in the calculation. 

 
Main window > Actogram > Graphs > Average > Select Days 

 

 

Activity 

 
 

The activity bar changes the threshold of the Y axis of the display, using 
either the sliding button, or by double-clicking the activity window at the 
bottom and typing in the value. 

 5-9



Actical® Instruction Manual 

Calculations Panel 
Several calculations are performed on the selected data. Calculations are 
made automatically any time a menu option is selected. 

 
Main window > Actogram > Graphs > Average 

 

Averaged Data  
Calculated statistics are based on displayed averaged data, i.e., consider 
this as the data on the display in front of you. These calculations make 
use of the calculated average data values for each epoch displayed, that is, 
they are “averages of averages.” 

NOTE: Downloaded data may not include a complete set of data values 
for each epoch on the first and final days of data collection. Epochs that 
fall before the start time, or after the download time, are included in the 
Averaged Data calculations as zeros. To eliminate those values from the 
calculation, it is necessary to set the Actogram Average screen to remove 
those data (by elimination of the first and last days, if they are not 
complete), or use the All Selected Data option, described below. 

All Selected Data 
When All Selected Data is chosen, the partial days at the beginning or 
end of the data set are eliminated. Calculated statistics are based upon all 
selected data. These calculations make use of actual recorded data values 
for the selected days and time interval. 

Average 

This is the average resulting from the above calculations. 

Standard Deviation 

This is a measure of how widely values are dispersed from the average 
value. 

Light Average 

Mean data value for those epochs that occur during the light period. The 
light and dark bars define this period. The settings for these bars can be 
changed in the actogram main display. 
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Dark Average 

Mean data value for those epochs that occur during the dark period. The 
light and dark bars define this period. The settings for these bars can be 
changed in the actogram main display. 

Light/Dark Ratio 

This is the light average divided by the dark average.  
Markers 

Main Window > Actogram > Markers 

   

This is a list of the event markers in the currently loaded data file. This 
list may be printed or cut to the Windows clipboard for export. 
 
 
Marker ticks 

        Ticks 
 

These markers can also be seen on the Actogram as small tick marks 
located below the baseline of the Actogram as shown above. 

 

 5-11



Actical® Instruction Manual 

Zoom Function 
This display is activated by double-clicking anywhere in an actogram. 

 

 
Actogram zoom 
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Zoom Display Details 

Display Center 
The red line represents the center of the displayed time. Use the sliding 
bar labeled Display Center to change the center time. 

Markers 
The blue lines represent event markers. 

Display Width 
Data may appear much as it did in the full actogram when the display 
width is set for 24 hours. However, by adjusting the Display Width 
sliding bar, samples may be studied in extreme detail. 

Graph 
The horizontal scale is time. The window of time may be adjusted using 
the two sliding bars. Activity data are represented by black vertical lines. 

The vertical scale is a quantitative number representing activity counts. 
When more activity occurs in one epoch, the number of counts increases. 
In the previous two illustrations, the epoch length is one minute. As the 
accelerometer detects motion during that minute, the activity counts are 
collected, and at the end of the minute displayed. 

 5-13



Actical® Instruction Manual 

 5-14

 



Actical® Instruction Manual 
 

SECTION 

ENERGY EXPENDITURE 
This section explains Actical’s Energy Expenditure feature. In this mode, 
Actical converts movement (activity counts) into energy units (calories). 
This display is accessed from the Main window toolbar. 

 
Energy Expenditure display 
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Basic Display Properties 
The Energy Expenditure display, portions of which are shown below, is a 
variety of graphically represented information, including activity, time, 
and energy expenditure. 

The X-axis is time divided into hourly increments represented by the 
gray lines. The Y-axis is energy expended, expressed in kilocalories. 

To assist in identifying the functions of the display, pop-up help tools 
will appear when the cursor is placed on certain areas of the graph or 
toolbar. 

There are two ways to view Energy Expenditure: Basic and Advanced. 
These views can be toggled from the toolbar. The following are the Basic 
features of Energy Expenditure. 

Basic Display (top) 
 

 

Basic/Advanced 

 
Day bar 

Daily energy expenditure

Hourly sum of energy expenditure 

Steps

Activity 
Activity scale 

Hour scale 

Gray areas 
This means there is no data there. 

Activity Counts 

  

The black graph within the green graph represents activity counts. The 
activity is similar to the actogram. This scale can be changed. See 
Activity Scale on the next page. 

This function can be shown or hidden by using the toolbar symbol.  
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Steps 
 

          
The blue graph represents steps taken per epoch.  

This function can be shown or hidden by using the toolbar symbol. 

Hourly Energy Expenditure  

 
The green graph represents the sum of energy expended per hour. Part of 
the equation factors in weight, and the results are expressed in 
kilocalories per hour. This scale can be changed (see Hour Scale below). 

This function can be shown or hidden by the toolbar symbol. 

Event Markers 

 
Event markers are shown as red triangles. Place the cursor above the 
triangle to show when the event marker button was pressed during data 
collection. 

Hour Scale 

 
The maximum value of the Y-axis (in kilocalories per hour) can be 
adjusted by either clicking on the arrows, or entering a value of your 
choice. 

Activity Scale 

 
The black graph activity scale (in counts per minute) can be changed by 
either clicking on the arrows, or entering a value. 

Daily Energy Expenditure 
This information is given in the column on the right side of the display. 
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Day Bar 
The bar on the right side of the display is used to shift the display one 
day at a time by clicking on the arrows, or jump to the first day or last 
day of collection by clicking in the area above or below the bar. 

 

Basic Display (bottom) 

 

Number of days 
displayed 

Epoch label

 # of samples S/N of deviceStart time

 
Subject information 

The bottom half of the display contains other important information. 

Status Bar 
The Status Bar is located at the bottom of the Energy Expenditure 
display. It contains the description of the subject and other relevant 
information. 

Time Scale Minimum 
This function selects the portion of the day which is displayed, shifting 
the data horizontally. Activity of interest can be centered in the graph by 
clicking on the arrow. The pop-up allows you to choose from 00:00 to 
23:00 hours. 

Number of Days Displayed 
The number of days shown in the Energy Expenditure display can be 
chosen by clicking in the field and entering the desired number. 1 to 99 
days can be displayed. Note that when selecting higher numbers of days, 
the day-graphs become compressed. 
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Epoch Label 
Placing the cursor and clicking anywhere above or within the activity 
graph will produce a label for the respective epoch. The Epoch Label 
contains the following information: 
 

Epoch Label details 

 

enditure Value
Physical Activity 
IntensitTime Energy Exp y

 

Individual epochs can be viewed by using the arrow keys: 

• Up/down arrow keys shift the epoch cursor from day to day. 

• Right/left arrow keys move the epoch cursor back and forth in one-
minute increments. 

• Ctrl + right/left arrow keys move the epoch cursor back and forth in 
one-hour increments. 

The following is a synopsis of the Epoch Label. Additional information 
on these statistics can be found in section on the Statistics Table on page 
6-16. 

Date, Time 

This is the time when the epoch was recorded. 

Activity Value 

Total activity counts within the epoch. 

Steps 

Steps taken within epoch.  

Energy Expenditure Value 

This is the energy expenditure for the epoch multiplied by the subject’s 
weight. 

Hourly energy expenditure 

Total energy expenditure for the hour (green graph). 

Date Activity Value Hour EE Total Marke

 Score

Steps r
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Physical Activity Intensity Scores 

This is a series of physical activity energy levels. These are discussed in 
detail in the section on Advanced Analysis Properties on page 6-23. In 
essence, these are as follows: 

Tag Activity Activity Example 

Sed Sedentary Sleep or rest 

Light Light Sorting cards, writing letter 

Mod Moderate Sweeping floors, vacuuming, dusting 

Vig Vigorous Treadmill walking 2.5 to 3.0 mph   
Treadmill jogging 4.5 mph 

 

Marker 

If the marker button was pressed during data collection, an M will 
indicate this action. 
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Basic Display Toolbar - Left Side 
This is the toolbar at the top of the Energy Expenditure display. Activity 
count data and Hourly Energy Expenditure have already been explained 
(see Activity on page 5-9). Note that this toolbar will change when 
Advanced mode is activated. 
 
Toolbar - left side 

 

File 

 
When clicked, this will open a new file. If a file is already open, it will 
ask to save the current file. 

Save 

 
This will save the data and current settings to an .awcEE file. 

Print 

 
Click to print an Actical Activity and Energy Expenditure Report. This 
report contains subject information, energy expenditure, activity counts, 
and statistics. 

Copy to Clipboard 

 
This function will copy the entire Energy Expenditure actogram to the 
Windows clipboard. It can then be pasted into a variety of application 
programs. 

View Epoch-by-Epoch List 

 
Clicking on this symbol presents a list of each epoch and the respective 
data. Within the View Epoch-by-Epoch List, there are options to allow 
exporting or copying the list to the Windows clipboard. If exporting, the 
file will have a .csv extension (Actical export file). 
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NOTE: Even if short (15 or 30 second) epochs have been chosen during 
setup, Actical has converted them into one-minute epochs for energy 
expenditure analysis. However, the raw 15 or 30 second epoch data are 
preserved in the .awc and .awcEE files. 
Epoch-by-Epoch list 

 
 

NaN (Not a Number) 

It is possible that due to device error, out-of-range activity, or not enough 
data to compute an output, an output for an epoch may be given as NaN. 
This is an acronym for Not a Number, a standard abbreviation for invalid 
data or incomplete computational data. Such an epoch will have a gray 
vertical line on the graph. 

In the previous list, for example, the first two entries are NaN. 
Computing energy expenditure values requires three minutes of data 
history, which is not true until the end of the third minute. At the end of 
the first and second minutes, there was not enough data to compute the 
energy expenditure output. Therefore, NaN was inserted in the first two 
epochs. 
When NaN appears on the Total Daily Energy Expenditure column (see 
Basic Display Properties), this means there was not enough data to 
compute one of the total daily outputs. To see the energy expenditure for 
the data acquired, select View > Statistics > Whole Data Set, and refer to 
the TotEE column. For details on this window, see the section on the 
Statistics Table on page 6-16. 

View Marker List 

 
Clicking the Event Marker symbol produces a list of markers generated 
during data collection. Within the Marker List, there are options to allow 
exporting or copying the list to the Windows clipboard. If exporting, the 
file will have a .csv extension (Actical export file). 
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Marker list 

 

View Statistics Table 

 
The statistics table is a comprehensive table of statistical results 
computed for given time intervals. 

Because of the extent of this feature, the statistics table is discussed in a 
separate section (see the section on the Statistics Table on page 6-16). 

 

Set Scales for Best Viewing 

 
This autoscale function adjusts the Energy Expenditure and Activity 
Count scales to a nominal level so that the data are best viewed. 

 

Restore Factory Defaults 

 
All settings that are accessible by the researcher, e.g., graph scales, 
display size, window settings, etc., will be restored to Factory Default 
status. 
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Basic Toolbar - Right Side 
The right side of the toolbar is more subject-related, and can be changed 
to match up to 24 subject models based on energy output type, regression 
type, age level, and location of the device. 
 

Toolbar - right side 
 

 
 

AEE and METs 

 

Actical has two energy units available. The choice depends on whether 
the resting metabolic rate is to be included in the total energy expenditure. 

• AEE is an acronym for Activity Energy Expenditure. This is the 
number of kilocalories expended per minute per kilogram of subject 
weight. 

The AEE values for a given time span are summed and multiplied by 
the subject’s weight in kilograms. This yields the total kilocalories the 
subject expended during the time span as a result of their activity 
above the resting metabolic rate. 

• MET is an acronym for Metabolic Equivalent. It is the total amount of 
energy the body uses to sustain itself, including the basal metabolic 
rate.  

The difference can be easily seen by clicking between AEE and METs 
and observing the change in Total Daily Expenditure. 

 

1R and 2R Scatter Plots 

 
 

A linear regression line is a straight line through a set of observations 
that attempts to fit itself to the data. The linear regression process adjusts 
the line so that the sum of the squares of the residuals is made as small as 
possible (least squares). 

Active energy expenditure and activity counts are shown on the 
following scatter plots.  

The following plots illustrate a mix of light-moderate to vigorous activity. 
The cluster of data points in the lower left is primarily light-moderate 
activity. The regression line is a best-fit to all data points shown. The 
first shows a single regression line  (1R). 
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Single regression line model (1R) 

 

 

In the scatter plot below, two regression lines have been fitted to the 
data: one to the light-moderate activity cluster; one to the vigorous 
(walking and jogging) activity cluster. 
 
Double regression line model (2R) 

 

It is beyond the scope of this publication to explain in detail the 
differences between the two models and which one should be used. That 
is best left up to the researcher considering the particular type of data 
collected, e.g., moderate or vigorous. However, if in doubt as to which 
regression model is appropriate, it is suggested that the 1R model be 
applied. 

Age Level 

This is an override function. The age entered at setup automatically 
adjusts this setting. However, it can be changed during analysis. 
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Location 

 

Location of the Actical activity monitoring device during data collection 
has an effect on the algorithm and must be taken into account in the 
regression model. This is an override function. (When opening an .awc 
file for analysis, a prompt will ask you where the activity monitoring 
device was placed during data collection.) 

• Hip – This is considered to be the most accurate position. However, 
on occasion, younger subjects have shown to be intolerant of hip-
mounted devices. 

• Wrist – This is considered to be the second choice for accurate 
measurement of energy expenditure. 

• Ankle – This is considered to be the third choice for accuracy, 
however, in many cases it has shown to be the most tolerated. 

6-12 



Actical® Instruction Manual 
 

Custom Interval 
Data of interest within a period of time can be computed by selecting the 
start and end times. Once selected, the Custom Interval computations can 
be seen in the Statistic Table under Custom Intervals (see the section on 
the Statistics Table on page 6-16). Up to 500 custom intervals may be 
selected. 

1 Left-click on the epoch with which you want to start the custom 
interval. Use the arrow keys to “fine select” the epoch.  
Press the letter C. The start interval will be shown in red. 

 
Start interval 

 

2 Left-click on the epoch with which you want to end the custom 
interval. Press Shift-C. The end of the interval will be shown in red. 

 
End interval 

 

3 Press Ctrl-C. This will create the custom interval (in blue), and make 
it available for computation. 
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Custom interval established 

 

There are several methods by which custom intervals can be built: 

1 Ctrl-left-click - Begin custom interval 

2 Ctrl-right-click - End custom interval 

3 Ctrl-C - Create custom interval 
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You may also left-click to establish an epoch label, then right-click to 
use the pop-up menu. 
 
Custom interval pop-up  

 

Deleting Custom Intervals 

To delete a single custom interval, select the custom interval by left-
clicking within it, and press Alt-Delete. 

You may also left-click within the custom interval, and use the pop-up 
menu. 

To delete all custom intervals, press Ctrl-Alt-C. 
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Statistics Table 
The statistics table is a compilation of 29 computations organized by 
time interval and category. In the following descriptions, the Statistics 
Table is broken down into segments to better facilitate explanation.  

To observe the Statistics Table, click on the table symbol.  
 

The first five columns are essentially the “header” information. Each day 
of study is divided into Start Date, Start Time, End Date, End Time, and 
the time in that period given in minutes. 
 

 
 

Energy and Activity 

 

 

Total number of steps taken during the elapsed time. 

 

 
Total Energy Expenditure within the given time interval as expressed 
in kilocalories. 

 

 
Average Energy Expenditure is the total energy expenditure within the 
given time interval, divided by the time interval duration in minutes as 
expressed in kilocalories per minute. 

 

 
Total Activity Counts are within the given time interval. 
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Average Activity Counts is the total activity counts within the given 
time interval, divided by the time interval duration (in minutes). 

Energy Expenditure 

 

Energy Expenditure is the energy expended within each activity range 
during the given time interval, expressed in kilocalories. 

Average Energy Expenditure 

 

 

Average Energy Expenditure is the energy expenditure within each 
activity range during the given time interval, divided by the total 
accumulated time within each activity range. 

 

Time Accumulated 

 
 

 

This shows the Total Time Accumulated in minutes within each activity 
range during the given time interval. 
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Ratio of Accumulated Time to Total Time 

 
This is the total accumulated minutes within each activity range within 
the given time interval, divided by the time interval duration, multiplied 
by 100.  

 

Sum of Activity Counts 

  
This is the total number of activity counts within each activity range 
within the given time interval. 

 

Average Activity Counts 

 

 
 Average Activity Counts is the total number of activity counts within each 
activity range within the given time interval, divided by the total 
accumulated time within each activity range. 

Statistics Interval Bar 

 
Using the Statistics Interval Bar, the previously described statistics in the 
Statistics Table can be computed for the following intervals: 

• Data accumulated for each day 

• Data accumulated for each hour 

• Data chosen within a custom interval 

• Beginning to end of the entire data set 
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Basic Display Menu Items 
File 

 

Load 

Load is identical to the Main Actical window menu functions.  

Save 

This menu item will save .awcEE files. 

Export is explained later. See Exporting Energy Expenditure Data on 
page 6-27. 

 

Print Report 

The report contains subject information, header information, statistics, 
activity and EE graphs, markers, and more. 
 
Print report 
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Edit 
Edit allows editing of the subject information. A cautionary statement 
will appear warning that certain changes may affect the computations. 
 
Editing subject information 

 

 

Copy 
The copy function offers several choices which can be copied to the 
Windows clipboard and pasted in other applications. 
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Actogram Graphics 

This selection copies the actogram onto the Windows clipboard. 
 
Actogram graphics 

 

Statistics 

This function copies all statistics as seen in the statistics table. 

 

Epoch-by-Epoch-List 

This selection copies the epoch-by-epoch list to the clipboard. 

 

 

Statistics and List 

This copies both the statistics table and the epoch-by-epoch list to the 
clipboard. 
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Event Marker List 

This copies the event marker list to the clipboard. 
 
Marker list 

 

 

View 
This menu has some redundant features for the convenience of the 
researcher. 
 

 

Statistics 

This menu item is identical to the toolbar symbol discussed on page 6-9. 

 
 

Epoch-by-Epoch List 

This menu item is identical to the toolbar symbol discussed on  
page 6-7. 

 
 

Event Mark List 

This menu item is identical to the Marker List toolbar symbol discussed 
on page 6-8. 
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Advanced Analysis Properties 
The Advanced Display features are accessible by clicking on the symbol. 
Several changes are readily apparent.  

 

• Three additional buttons on the toolbar 

• Three new types of outputs on the actogram 

• Two additional controls 
 

Advanced analysis actogram 

 

Energy Expenditure Data  

This advanced feature hides or shows the energy expenditure data. Note 
that this is the raw expenditure of energy without weight as part of the 
equation.  

• When AEE output data is selected, the units of this graph are 
kcals/min/kg. 

• When MET output data is selected, the units are in METs. 
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Physical Activity Intensity  

This controls the visibility of the physical activity intensity scores. The 
band of colors beneath the activity graph visually shows the intensity of 
activity. Here is a portion of the scale greatly expanded. 

• Light gray - sedentary 

• Green - light 

• Blue - moderate 

• Red - vigorous 

Intensity
scores

 
 

 

Cutpoints  
The light-to-moderate and moderate-to-vigorous cutpoints can be shown 
or hidden. Cutpoints are demarcation points between ranges of activity. 
For example, at a specified point (the cutpoint), the level of activity will 
switch from moderate to vigorous. 

Although there are default cutpoints, special research projects may 
require different cutpoints to define what is considered moderate or 
vigorous. These cutpoints can be changed with the two cutpoint scales 
shown below. 

Note in the illustrations, the cutpoints of the bottom graph have been 
lowered so that less energy is required to produce moderate and vigorous 
activity. Also note the physical activity intensity scores have changed. 
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Cutpoints 

 
 

Cutpoint Defaults 
The following are the default cutpoints used in Actical. Also note in the 
two displays below the table, the difference between AEE and MET 
cutpoints. The reason is that AEE and MET use different algorithms.  
 

AEE 
Active Energy Expenditure 

(kcal/min/kg) 

MET  
(metabolic equivalents) 

Light to 
Mod. 

Mod. to 
Vigorous 

Light to 
Mod. 

Mod. to 
Vigorous 

0.031 0.083 3.0 6.0 
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File Formats 
File Types used in Energy Expenditure 

Actical uses several file types, some of which are unique to Energy 
Expenditure.  

.awc file 

This is an ASCII text file that contains the raw activity data as well as 
containing subject information.  It can be loaded from the File menu in 
the Main, Actogram, and Energy Expenditure windows. 

.awcEE file 

This is the same as the .awc file, except it contains Energy Expenditure 
display settings, custom interval data, and a file version number. It can 
be loaded from the File menu in the Main, Actogram, and Energy 
Expenditure windows. 

.csv file 

This is an export file in ASCII, comma delimited, spreadsheet format. 
There are 14 varieties of these files. Further information can be found in 
the next section under Export. 

.csv files will load directly into Excel. They cannot be loaded back into 
Actical in that they are export files. 

Here are the 14 types of .csv files: 

• _List.csv - Actical epoch-by-epoch data list 

• _EE.csv - Energy Expenditure export file (all statistics and epoch-by- 
epoch data list). 

• _Events.csv - Event marker list file 

• _W_Stats.csv - Whole data set statistics file 

• _D_Stats.csv - Daily statistics file 

• _H_Stats.csv - Hourly statistics file 

• _C_Stats.csv - Custom Interval statistics file 

• _A_Stats.csv - All statistics file 

• _SW_Stats.csv - Simplified whole data set statistics file 

• _SD_Stats.csv - Simplified daily statistics file 

• _SH_Stats.csv - Simplified hourly statistics file  

• _SC_Stats.csv - Simplified Custom Interval statistics file  

• _SA_Stats.csv - Simplified all statistics file 

• _Combined_Stats.csv - Combined simplified statistics file 
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Exporting Energy Expenditure Data 
Files containing a variety of information may be exported. Files are 
always exported in a comma delimited format, contain header 
information for data and subject identification, and are given a .csv 
extension. This extension enables the researcher to either open the file 
from Excel, or double-click on the file and the .csv file will open Excel 
and load the file automatically. 

Additional information on File Types can be found in the previous 
section. 
 
 
Exporting Actical data 

 

Export Statistics 
This option produces a file containing 29 statistics from the statistics 
table for all interval types and will include in its name: _A_Stats.csv. 
For example, it could be named “demodata_A_Stats.csv.”  

Export Epoch-by-Epoch List 

This list contains the following data: 

• Date 

• Time 

• Activity counts 

• Steps 

• Energy expenditure in kilocalories/minute/kilogram 

• Activity Intensity Score 

• Event Marker entries 
This file includes in its name _List.csv. For example, it could be 
named “demodata_List.csv.” 

Export Statistics and List 
This list contains the above Epoch-by-Epoch list in addition to the 
statistics table. This file includes in its name _EE.csv. For example, it 
could be named “demodata_EE.csv.” 
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Export Event Marker List 
This contains only the Event Markers. This file includes in its name 
_Events.csv. For example, it could be named 
“demodata_Events.csv.” 
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Batch Processing 
Batch processing is a function that allows multiple files with similar 
characteristics to be processed together. It is done with the Batch 
Processing wizard from the Main Actical window. 

Before batch processing, consider that age differences and other 
characteristics may generate inappropriate data or errors. To properly 
batch process, the data should be similar. 
 

1 From the Main window, select Batch Processing. 
 
Batch processing menu 

 

 

2 The wizard begins with a preliminary explanation of what is about to 
happen. 
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3 Only .awc and .awcee files can be processed using Batch Processing.. 

 

 

4 The wizard will activate a file browser. Then the multiple files can be 
selected. 
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5 Once selected, the files will appear in the wizard analysis panel and a 

folder path will be given as to where the processed files will be placed. 
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6 A series of choices are produced by the wizard to ensure the analysis 
parameters are correct, and to reduce the possibility of error caused 
by conflicting data. 

 

 
 

6-32 



Actical® Instruction Manual 
 

7 Progress will be noted as the export file is being processed. 

 

 

8 The wizard will wrap up the process and give a final report on the 
results. 
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APPENDIX 

Actical Battery 
Replacement 

Actical Battery Replacement 
All Actical devices use the CR2025 coin-cell battery. 

 
Note: To change the battery in ActiReader, see page 2-10. 

The Actical battery is required for data collection, reading and writing. 
Actical has a non-volatile memory, i.e., data stored are not lost after the 
battery has run down. If you are attempting to read a device with a low 
battery, the green LED will still light on the ActiReader. It is 
recommended that you keep a log noting the date of all battery changes 
for each Actical. 
 

CAUTION! It is important that you thoroughly read the following 
information before changing the battery. Failure to follow procedures 
may result in immediate or subsequent damage to the product. 

 
CAUTION! To retain the integrity of the waterproof seal, you should 
change the O-ring in the battery compartment at the same time you 
change the battery. 
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Replacement Items 
The Actical battery is a CR2025, 3-Volt, 220-mAmp-hour Lithium 
Manganese cell. To properly install this battery, specific items may be 
required. The items in the table below are included in the Battery 
Replacement Kit. 

 

Description 

O-ring 

Battery, 3V lithium cell (CR2025) 

Screwdriver, flat head 

Screw, machine, 1.6 x 6 mm 

Cotton swabs 

Instructions 

 

Additional materials that may be required: 
• Denatured alcohol 
• X-Acto® knife blade (with a flat tip) or another sharp knife 
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Battery Replacement Procedure 
NOTE: In the following illustrations, a standard AW-16/64 is shown. 
Actical has a slightly different battery cover. 

1 Remove the band from the watch. Use the screwdriver provided to 
loosen (approximately five full turns) or remove the screws in the slots 
in the back of the device. 

 
2 Carefully remove the battery cover by lightly pressing downward, and 

rotating the back clockwise. Remove the battery and discard it. See the 
warning below! 

WARNING!  Do not dispose of lithium batteries in fire or flame. An 
explosion may result. Only dispose in accordance with manufacturer's 
recommendation or local codes. 

 

CAUTION!  Use extreme care to avoid scratching the metal surface of 
the device or battery cover. Scratches can cause the Actical device to 
leak. 

 

3 Thoroughly clean the O-ring channel with a solvent such as alcohol.  

CAUTION!  Prior to assembling the device, check carefully for lint, 
hairs, or other debris which may compromise the seal integrity. 
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4 Place a new O-ring into the channel in the back cover as shown below. 
Use the following technique: 

• Pre-stretch the O-ring by gently flexing it in several directions. 

• Place a portion of the O-ring in the channel and hold it with your 
thumb or finger as shown below. 

 

 

• Use a finger on the other hand to guide the O-ring into 
the channel. 

• Be sure that the O-ring is properly seated in the channel, 
and is not twisted or deformed. 

O-ring channel

 
6 Place a new battery into the Actical case with the positive (+) side up, 

as shown below. 
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7 Replace the back cover on Actical and replace the screws. If the 
screws have not been removed completely, rotate the back cover 
counterclockwise until the slots in the back are firmly seated around 
the screws, and the back is square with the case. 

8 Tighten all four screws in an “X” pattern until all screws are snug (see 
the illustration below). Take care not to over-tighten to the extent of 
stripping the threads or twisting off the heads. 

 

1

2

3

4

 

CAUTION!  DO NOT over-tighten the screws. They can be stripped 
easily.  
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Testing Actical 

NOTE: If this Actical device contains data that need to be retrieved or 
saved, use Reader > Read, or Reader > Recover Data to download 
data before testing. For more information, see Recover Data on  
page 2-13. 

Test the Actical battery replacement using the Actical test procedure 
which follows.  

1 Select Test Actical from the Reader menu. 

2 Place Actical on the ActiReader so that the green LED lights up. Click 
OK. The reader and device will attempt to communicate. If 
successful, then the Actical device will be tested and a confirmation 
notice will appear. If not, it is likely that the battery was improperly 
installed. Re-install the battery and try again. 

3 When the test has been successfully completed, select Write from the 
Reader menu. 

4 Click the Battery Fitted Date in the Actical Setup as shown below. 
 
 

Entering Battery Fitted Date 

 
   
Click here to enter the battery fitted date 
 
 

5 You may now write a new Setup to Actical. See Setting Up Actical on 
page 4-1. Be sure to click Send to update the Battery Fitted Date. 

6 Re-install the wrist band on the device. 
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SPECIFICATIONS 
 

Actical Device Physical Attributes  
Parameter  Value  Condition/Note  
Size  29 mm x 37 mm x 11 mm  without band  

16 grams  without band  
Weight  

22 grams with standard band 

Case Material  Polyurethane/Polyester alloy  
Frame and Battery Cover Titanium  
Standard Wrist Band  Nylon with buckle   
Battery type  CR2025 lithium coin cell  User replaceable  
 

 
Actical Device Environmental Attributes  
Parameter  Value  Condition/Note  
Moisture protection  Waterproof  IEC60529 IPX7 
Storage temperature  -20 to 60 °C  15% to 95% relative humidity  
Transportation 
temperature  -20 to 60 °C  15% to 95% relative humidity  

Operating temperature 
range  5 to 40 °C  15% to 95% relative humidity  
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IEC 60601-1 Classification 
 Internally Powered 
 Continuous Operation 
 Type BF Applied Part 
 IPX7 Protection Against Water Ingress (Actical device) 
 Not suitable for use in the presence of a flammable anesthetic mixture with air or with 

oxygen or nitrous oxide. 
 

ActiReader Physical Attributes  
Parameter  Value  Condition/Note  
Size  114 mm x 72 mm x 34 mm  Outer dimensions 
Weight  158 grams   
Case material  ABS plastic  
Indicators  Red & Green LEDs   
 
ActiReader Environmental Attributes 
Parameter  Value  Condition/Note  
Moisture protection  Not water resistant   
Storage temperature  -20 to 60 °C  15% to 95% relative humidity   
Transportation temperature  -20 to 60 °C  15% to 95% relative humidity  
Operating temperature range  5 to 40 °C  15% to 95% relative humidity 
 

 
Regulatory Standards 
Actical has been tested according to the following standards:  
Test Standard  Description  Actical 

Sensor 
ActiReader 

IEC60601-1  Medical Electrical Equipment - Part 1: 
General Requirements for Safety  x   

IEC60601-1-2  Medical Electrical Equipment - Part 1-2: 
General Requirements for Safety - 
Collateral Standard: Electromagnetic 
Compatibility - Requirements and Tests  

x  x 

IEC60950-1  Information Technology Equipment - 
Safety - Part 1: General Requirements  

 x 
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Software Attributes 

Parameter  Value  Condition/Note  
Communication rate  600 baud  Configuration  
Communication rate  4800 baud Data retrieval  
Hardware platform  Personal computer (Pentium II or later)  
Compatibility  Windows® 98, ME, NT 4, 2000, XP   
Display resolution  800 x 600 or better   
Communication interface  9-pin or 25-pin RS-232 serial ports   
Communication cable  Straight-through serial cable   
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Hereby,  
  
Mini Mitter Company, Inc. 
A Respironics, Inc. Company 
20300 Empire Avenue, Building B-3 
Bend, OR  97701 
  
declares that this class 1 radio equipment is in compliance with the essential requirements 
and other relevant provisions of Directive 1999/5/EEC. It complies with the following 
harmonized standards for radio equipment: EN 300 220-3 V1.1.1 (2000-09), EN 301 
489-1 V1.4.1 (2002-08), and EN 301 489-3 V1.4.1 (2002-08).   
  

 
 
Florian Bell                                            Date  
Director of Engineering 
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EMC Requirements 

Guidance and Manufacturer’s Declaration –  
Electromagnetic Emissions 
 
This device is intended for use in the electromagnetic environment specified below. The user of 
this device should make sure it is used in such an environment. 

 

Emissions Test Compliance Electromagnetic Environment - Guidance 

RF emissions  
CISPR 11 

Group 1 This device uses RF energy only for its 
internal function. Therefore, its RF emissions 
are very low and are not likely to cause any 
interference in nearby electronic equipment. 
 

RF emissions  
CISPR 11 

Class B 

Harmonic emissions 
IEC 61000-3-2 

Class A 
 
 

Voltage fluctuations/ 
Flicker emissions  
IEC 61000-3-3 

Complies 

This device is suitable for use in all 
establishments, including domestic 
establishments and those directly connected 
to the public low-voltage power supply 
network. 
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Guidance and Manufacturer’s Declaration –  
Electromagnetic Immunity 
 
This device is intended for use in the electromagnetic environment specified below. The user of 
this device should make sure it is used in such an environment. 

Immunity Test IEC 60601 Test 
Level 

Compliance 
Level 

Electromagnetic Environment - 
Guidance 

Electrostatic 
Discharge 
(ESD)  
 
IEC 61000-4-2 

±6kV contact 
 
±8kV air 

±6 kV contact 
 
±8 kV air 

Floors should be wood, concrete or 
ceramic tile. If floors are covered 
with synthetic material, the relative 
humidity should be at least 30%. 
 

Electrical fast 
Transient/burst 
 
IEC 61000-4-4 

±2kV for power 
supply lines 
±1kV for  
input/output lines 

±2kV for supply 
mains 
 
±1kV for 
input/output lines 
 

Mains power quality should be that 
of a typical home or hospital 
environment. 

Surge  
 
IEC 61000-4-5 

±1kV differential 
mode 
 
±2kV common 
mode 

±1kV differential 
mode 
 
±2kV common 
mode 
 

Mains power quality should be that 
of a typical home or hospital 
environment. 

Voltage dips, 
short 
interruptions 
and voltage 
variations on 
power supply 
input lines  
 
IEC 61000-4-
11 

<5% UT 
(>95% dip in UT ) 
for 0.5 cycle 
40% UT 
(60% dip in UT)  
for 5 cycles 
70% UT (30% dip 
in UT) for 25 
cycles 
<5% UT (>95% 
dip  
in UT) for 5 sec 
 

<5% UT 
(>95% dip in UT ) 
for 0.5 cycle 
40% UT 
(60% dip in UT) 
for 5 cycles 
70% UT (30% dip 
in UT) for 25 
cycles 
<5% UT (>95% 
dip in UT) for 5 
sec 

Mains power quality should be that 
of a typical home or hospital 
environment.  

  Note: UT is the a.c. mains voltage prior to application of the test level. 
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Guidance and Manufacturer’s Declaration –  
Electromagnetic Immunity 
 
This device is intended for use in the electromagnetic environment specified below. The user of 
this device should make sure it is used in such an environment. 

Immunity test IEC 60601 
Test Level 

Compliance 
Level (FDA) 

Electromagnetic Environment - 
Guidance 

Power frequency 
(50/60 Hz)  
magnetic field 
 
IEC 61000-4-8 

3 A/m 3 A/m Power frequency magnetic fields should be 
at levels characteristic of a typical location in 
a typical home or hospital environment. 

 
 
 
 
 
 
 
 
Conducted RF 
IEC 61000-4-6 
 
 
 
 
Radiated RF 
IEC 61000-4-3 

 
 
 
 
 
 
 
 
3 Vrms 
150 kHz to 80 
MHz  
 
 
 
3 V/m 
80 MHz to 2.5 
GHz 

 
 
 
 
 
 
 
 
3 Vrms 
 
 
 
 
 
 
3 V/m 

Portable and mobile RF communications 
equipment should be used no closer to any 
part of the device, including cables, than the 
recommended separation distance 
calculated from the equation applicable to 
the frequency of the transmitter.  
 
Recommended Separation Distance       
 

Pd 2.1=  
 
 

Pd 2.1=     80 MHz to 800 MHz      
 

Pd 3.2=    800 MHz to 2.5 GHz 
 
where P is the maximum output power rating 
of the transmitter in watts (W) according to 
the transmitter manufacturer and d is the 
recommended separation distance in meters 
(m). 
 
Field strengths from fixed RF transmitters, 
as determined by an electromagnetic site 
survey,a should be less than the compliance 
level in each frequency range.b  
 
Interference may occur in the vicinity of 
equipment marked with the following 
symbol: 

 
Note 1: At 80 MHz and 800 MHz the higher frequency range applies. 
 
Note 2: These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and 
reflection from structures, objects and people 
a Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and land 

mobile radios, amateur radio, AM and FM radio broadcast and TV broadcast cannot be predicted theoretically 
with accuracy.  To assess the electromagnetic environment due to fixed RF transmitters, an electromagnetic site 
survey should be considered.  If the measured field strength in the location in which the device is used exceeds 
the applicable RF compliance level above, the device should be observed to verify normal operation. If abnormal 
performance is observed, additional measures may be necessary, such as re-orienting or relocating the device. 

b Over the frequency range 150 kHz to 80 MHz, the field strengths should be less than 3 V/m. 
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Recommended Separation Distances between Portable and 
Mobile RF Communications Equipment and This Device 
 
This device is intended for use in an electromagnetic environment in which radiated RF 
disturbances are controlled. The customer or the user of this device can help prevent 
electromagnetic interference by maintaining a minimum distance between portable and mobile 
RF communication equipment (transmitters) and this device as recommended below, according to 
the maximum output power of the communications equipment. 

 
Separation Distance According to Frequency of Transmitter (m) Rated 

Maximum 
Power Output 
of Transmitter 
(W) 

150 kHz to 80 MHz 
Pd 2.1=  

80 MHz to 800 MHz 
Pd 2.1=  

800 MHz to 2.5 GHz 
Pd 3.2=  

0.01 0.12 0.12 0.23 

0.1 0.38 0.38 0.73 

1 1.2 1.2 2.3 

10 3.8 3.8 7.3 

100 12 12 23 
 
For transmitters rated at a maximum output power not listed above, the recommended separation distance d in meters 
(m) can be estimated using the equation applicable to the frequency of the transmitter, where P is the maximum output 
power rating of the transmitter in watts (W) according to the transmitter manufacturer. 
 
Note 1:  At 80 MHz and 800 MHz, the separation distance for the higher frequency range applies. 
 
Note 2:  These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and 
reflection from structures, objects and people. 
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Redraw · 5-3, 5-6 
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Steps · 4-5 
Sum of Activity Counts · 6-18 
System Requirements · 2-1 
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Ticks · 5-11 
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View Menu · 6-22 
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W 

Waist Placement · 3-1 
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